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Introducing FirstClass
FirstClass is an easy-to-use, advanced communications and information system. With FirstClass, you can:
•	send and receive electronic mail (email), voice mail, and faxes
•	transfer text and graphics files so that other users can access them
•	browse and send messages to online forums
•	organize items for easy access
•	publish information on the World Wide Web (web).
Depending on the way your administrator has set up your user account, you may not be able to use all of FirstClass' features. For example, you may be able to read messages in certain areas, but not delete them.
If you are unclear about whether you should be able to use a particular feature, contact your administrator.
For detailed information about how to update a FirstClass form, choose Help > About this Window with the form open.
For more information about our products, or to download software, visit our web site at www.centrinity.com.
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New in this version
General
•	automatic generation of a home.fc settings file that knows your server's name
•	specify the time zone for your client
•	import POP3 mail from other mail accounts
•	type users' names to locate them in the Who's Online list
•	search message and document histories
•	change your Mailbox and personal calendar permissions
•	create slide presentations
•	add background pictures to messages and documents
•	create bookmarks without having to select the target object
Views
•	view your Desktop in a three-pane Explore view, optionally start in this view, and browse messages in this view by pressing the space bar
•	display message and document content as it would print or as slides in a presentation
•	specify default content view and magnification
•	change content magnification temporarily
•	resize and rotate pictures in viewer windows
Menus and toolbars
•	reorganized and simplified menus, with the Conferencing and Connection menus merged into the new Collaborate menu
•	display text plus icons or only icons on toolbar buttons
File transfer
•	attach FirstClass objects
•	attach uploaded files and files attached to other objects
•	attach files to personal addresses
Calendaring
•	check participants' free times and conflicts
•	calendar events display whether participants have accepted or declined
•	make exceptions to repeating events
•	specify the start and duration of your work day, plus default event start times and duration
Printing
•	print immediately from the toolbar button
•	specify print layout options for different types of objects
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FirstClass objects
Messages
Messages are pieces of email that are sent through FirstClass. Messages may be sent:
•	locally on the same FirstClass server
•	through a gateway that connects another FirstClass server or another messaging system
•	through the Internet to anyone who can receive email.
Documents
You can create documents in FirstClass much as you do messages. These are the differences between a message and a document.
A message:
•	is intended for mailing to someone electronically, and therefore includes space for address information
•	cannot normally be edited after being sent (although FirstClass does let you unsend a message)
•	expires after a certain period by default
•	is automatically named with the name of the sender (for mail received) or recipient (for mail sent).
A document:
•	is intended for posting directly to an area where others can see it, and therefore cannot be mailed
•	can be edited after it has been posted
•	never expires by default
•	must be named explicitly.
Uploaded files
There are several ways to transfer text and graphics files so that they are available to others. You can attach these files to messages (or insert them in message bodies), or copy the files directly to FirstClass. These files are all called uploaded files.
Folders
FirstClass folders work just like other folders you are used to on your operating system. You can create and name folders, then put messages and documents in them to organize your work area for easy access.
In addition, your administrator may create external folders.
Conferences
At first glance, FirstClass conferences look just like folders. A conference serves the same purpose of putting items with a common topic into one place, but there are some important differences.
A conference:
•	is intended mainly as an online forum for the exchange of information
•	has controlled access; you need to be given certain permissions to be able to see and work with it
•	can be the recipient of messages
•	is flagged when it contains unread mail.
A folder:
•	is intended mainly as an organizational aid
•	does not have directly controlled access; the object within which the folder was created determines the folder's access
•	can only hold messages that have been moved there
•	does not indicate that it contains unread mail.
Calendars
FirstClass includes online calendars that record time commitments, such as meetings, and tasks that you need to complete. In addition to your own personal calendar, you may have access to public calendars that let you schedule meetings at mutually convenient times.
Your Desktop
Once you are connected to a FirstClass server, your Desktop opens. It contains your Mailbox, plus any containers that you or your administrator have placed on your Desktop.
Your Mailbox
Your FirstClass Mailbox contains:
•	messages that have been sent to you
•	all messages that you have sent
•	messages that you have created but not yet sent.
Changing your Mailbox permissions
You can update the permissions on your Mailbox to:
•	stop messages above a certain size from being accepted
•	specify when messages expire
Expired messages are deleted automatically.
•	control specific users' access to your Mailbox.
To update your Mailbox permissions:
1	Select or open your Mailbox.
2	Choose Collaborate > Permissions.
3	Update the Mailbox Permissions form.
Reminder
You can access detailed information about Mailbox permissions by choosing Help > About this Window with the Permissions form open.
Your changes are saved automatically when you close this form.
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About the FirstClass system
Servers
A server stores all your messages and documents, and the Mailbox, conference, and folder structure that contains these items. It also contains information about all the users known to the server.
When you log into FirstClass, you connect to a server. Your organization may have multiple servers, and you may be able to connect to some of these servers as well. On each server, you will see the objects that the administrator for that server has given you permission to see.
The server to which you normally connect is considered your home server.
Clients
Client software runs on your computer. It connects to a server, and provides the interface (such as menu commands) that lets you work with FirstClass objects.
You can use one of the following clients to connect to a server:
•	the FirstClass client, which runs on Windows, Mac OS, or UNIX
•	a web browser
•	a phone
•	a handheld device.
Note
This help is based on the release level of your server. If it does not seem to describe the client that you are running, contact your administrator to check which client release you should be using.
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Connecting to servers
About logging in
Depending on how your administrator set up the server and your user account, you may be able to connect (log in) to a server as:
•	a registered user
Your administrator provided you with a personal user ID and password.
•	a user who can autoregister
Your administrator set up the server to allow autoregistration. When you autoregister, you supply the user ID and password that you want to use for future connections. The next time you log in, you do so as a registered user.
•	a guest user.
You do not require a user ID or password. Guests are generally more limited in what they can do than registered users.
To log in as a registered user
1	Double-click the FirstClass icon.
2	Update the FirstClass Login screen.
3	Click Login to open your FirstClass Desktop.
To autoregister
1	Double-click the FirstClass icon.
2	Update the FirstClass Login screen.
For "User ID" and "Password", use the values that you want to use to connect to this server in the future.
3	Click Login.
4	Update the Autoregistration form.
5	Click Register.
6	Record your user ID and password from the confirmation screen for future use.
7	Click one of the following:
•	OK - opens your FirstClass Desktop
•	Save - opens your FirstClass Desktop and saves your user ID and password in the settings file.
If you click Save, your user ID and password will be displayed on the FirstClass Login screen the next time you choose this server. If you do not want this information displayed automatically for security reasons, click OK instead.
To log in as a guest user
1	Double-click the FirstClass icon.
2	Update the FirstClass Login screen.
3	Click Login to open the guest account's FirstClass Desktop.
Logging in using an IMAP client
If you have a client that supports the IMAP4rev1 standard (Netscape IMAP client, or a Microsoft IMAP client such as Outlook Express), you can use this client to connect to a FirstClass server.
For instructions, see your client documentation.
Changing your password
If you are a registered user, your administrator provided you with a user ID and a password to give you access to a server. For security reasons, we recommend that you change the password to something only you know.
Make your password difficult to guess. Consider mixing numbers and letters. Do not use your own name or user ID, or any other easily guessed value, such as your birth date or the name of a family member or pet.
The maximum length of a password is 12 characters.
To change your password:
1	Log into the server for which you want to change your password.
2	Choose Collaborate > Change Password.
3	Update the Change Password form.
About settings files
FirstClass stores the information needed to connect to a server in a settings file. Settings files can also store resources used by FirstClass, such as forms, pictures, and sounds. In Windows, settings files always end in .fc.
FirstClass includes a home.fc settings file. If you downloaded FirstClass from your server and followed the instructions there, this settings file already knows your server's name.
In addition, your administrator may have provided you with a settings file that contains the necessary information for logging into your server. If this is the case, put this file in the Settings folder inside the FirstClass application folder.
Updating settings files
You may need to change connection information for an existing settings file, or incorporate changes from another settings file (such as one supplied by your administrator) into your own settings file.
To change connection information
1	Click Setup on the FirstClass Login screen.
2	Change the information as required.
To incorporate changes from another settings file
1	Log into FirstClass using the settings file that you want to update.
2	Double-click the settings file that contains the updates.
If this settings file is attached to a message, you can double-click it directly from the message.
3	Click Update at the Resource Updater screen.
Note
If the settings file is large or you are on a slow connection, you may have to wait for this screen to open.
Clearing resources from settings files
FirstClass can import a picture or form resource from your server as you need it; however, it will only do so if you do not already have a copy of the resource in your settings file.
If you know that there are updated resources on the server, and you want to import them, you must clear your old resources from your settings file. Clearing resources does not affect the connection information that is stored in your settings file.
To clear resources from your settings file:
1	Open the FirstClass Login screen.
Note
Do not log in. You cannot clear resources from your settings file while you are connected to the server.
2	Make sure the settings file you want to clear is displayed at "Address".
3	Click Setup.
4	Click Flush Cache.
Clearing settings files from the FirstClass Login screen
As you select and create various settings files, the list of files grows at "Address" on the FirstClass Login screen. If this list becomes unwieldy, you can clear files from it. Cleared settings files remain in FirstClass' Settings folder, so you can still browse to select them.
To clear the settings file displayed at "Address", open the shortcut menu from it, then choose Clear.
Connecting to multiple servers
If you have access to multiple servers, you can connect to more than one at the same time. You will see a Desktop for each server to which you are connected.
To connect to multiple servers:
1	Log in as you normally do, choosing the settings file for the first server at "Address" on the FirstClass Login screen.
2	Choose Collaborate > Connect to reopen the FirstClass Login screen.
3	Log in as you normally do, choosing the settings file for the second server at "Address".
4	Repeat as many times as required.
Logging in with multiple user IDs
If you have multiple user IDs, or can autoregister, you can open multiple connections to the same server with different user IDs. You will see a Desktop for each user ID.
To log in with multiple user IDs:
1	Log into the server as you normally do, using the first user ID and password with which you want to connect.
2	Choose Collaborate > Connect to reopen the FirstClass Login screen.
3	Log in using the second user ID and password with which you want to connect.
4	Repeat as many times as required.
Logging in from multiple computers
Your administrator may allow you to log into the same server using the same user ID and password from multiple computers.
If you are connected multiple times using the same user ID, and your administrator has limited the length of time you can connect per day, be aware that the time spent by all connections is added together and counted against your daily time allotment.
Example
If your first connection has been active for 30 minutes, and your second connection has been active for 15 minutes, you are considered to have used up 45 minutes of your daily time allotment.
To log in from multiple computers, simply log in as you normally do from each one.
Checking your connections
To see a list of all servers to which your computer is connected, and all user IDs used for these connections, choose Collaborate > List Connections.
The Connections List shows this information:
•	Site Name - the server to which you are connected
•	User ID - the user ID with which you are connected to this server
•	Connect Time - the length of time you have been connected, in hh:mm:ss format
•	Time Left - the length of time you have left before you will be automatically logged off.
Your administrator may have defined a maximum time that you can be connected per day. If a dash shows here, you do not have a daily connection time limit for this server and user ID.
•	Items - the number of objects open for this connection.
To bring all windows for a particular connection to the foreground, in the order they were opened, double-click the connection in the list.
To end a connection, select it, then click Disconnect Selected.
To end all connections, click Disconnect All. FirstClass continues to run on your computer when you do this.
Disconnecting from a server
You can disconnect from a server in the following ways:
•	to end your current connection, choose Collaborate > Disconnect, or close all open windows for this connection
•	to end all connections and quit FirstClass, choose File > Exit (Windows) or Quit (Mac OS).
In addition, you can use the Connections List to disconnect from servers as well as check your connections.
Connecting automatically
You can connect to a server as soon as you start FirstClass, without having to update the FirstClass Login screen. To do this, you must use a settings file configured for automatic login to start FirstClass.
Note
For security reasons, we recommend that you do this only in an environment where other users cannot access your computer.
To configure the settings file:
1	Start FirstClass.
2	Choose the settings file at "Address" on the FirstClass Login screen, or type the name for a new settings file.
3	Click Setup.
4	Update the "User ID" and "Password" fields, if these are blank.
If this is a new settings file, also update the fields required for your connection.
5	Select "Log in automatically".
To use this settings file to connect automatically, double-click it or drag it over your FirstClass application.
You can disable automatic connection by pressing Control (Windows) or Option (Mac OS) while you open the settings file.
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Configuring connections
If you just use home.fc to connect to your server, and this connection works the first time you click Login, you will not need to configure your connection. You only need to read the rest of this section if you must change connection information for home.fc or you want to configure a connection to another server.
About your connection protocol
You can connect to a server in one of two ways:
•	over a network
•	using a modem or ISDN line.
Note
We assume that your connection is already set up and working properly. We only discuss how to tell FirstClass about your connection. If you do not know what connection protocol to use, contact your administrator.
Network connections
In a network connection, your computer is plugged into a local network that allows you to communicate with any other computer within the network. This is the most common method for people connecting from medium to large sized businesses.
A network connection uses one of the following protocols:
•	TCP/IP
•	UDP/IP
•	AppleTalk
•	IPX.
Modem connections
If you are using a modem connection direct to your server, the modem used by your computer uses a telephone line to communicate with a modem at the server site.
A modem connection uses one of the following protocols:
•	Windows modem
•	FirstClass or serial modem
•	Comm Toolbox or Comm Toolbox Serial
•	ISDN.
Protocol types
These are appropriate protocols for each connection type and system:
Internet connections
Windows:TCP/IP, UDP/IP
Mac OS: TCP/IP, UDP/IP
Network connections
Windows: TCP/IP, UDP/IP, IPX
Mac OS: TCP/IP, UDP/IP, AppleTalk
Modem connections
Windows: Windows modem (TAPI), FirstClass modem
Mac OS: serial modem, Comm Toolbox, Comm Toolbox Serial
ISDN connections
Windows: ISDN (CAPI)
Mac OS: Comm Toolbox
Additional notes on protocols
TCP/IP
Use this protocol if you are using a modem to connect through an Internet Service Provider (ISP) over the Internet.
UDP/IP
This is an alternative to TCP/IP when your connection is slow. It optimizes data flow to provide better interactive response.
Windows modem
Windows NT 4.0, Windows 95, or later include TAPI, a technology that lets you configure modem connections using system information already known to Windows.
FirstClass modem
Use this protocol if you want to use FirstClass' own Windows modem handling. You will have to supply more information than you would for a Windows modem connection.
ISDN
ISDN is a digital telephone line that provides greater speed than a regular telephone line.
Comm Toolbox Serial
Use this protocol if your Comm Toolbox cannot directly access the serial card in your computer.
Information you must supply
There are two types of information you need to supply when configuring a connection:
•	service setup information
This includes information such as the connection protocol you will use, and the server you want to access.
•	connection information
This includes information such as the port, modem type, or phone type you use. Not all connection protocols require you to supply connection information.
If you do not have some of the information you require after reading this help, contact your administrator.
TCP/IP or UDP/IP information
To configure a TCP/IP or UDP/IP connection, you need the following information:
•	whether you are connecting directly to the server or through a proxy server (your company may use a proxy server if your internal network is protected by a firewall)
•	the server's IP address or domain name
•	the port number of the server
•	the proxy server's IP address and port number (if you are connecting through a proxy server).
AppleTalk information
To configure an AppleTalk connection, you need the following information:
•	the server's network name
•	the name of the AppleTalk zone in which the server is located, if it is different from your computer's zone.
Comm Toolbox information
To configure a Comm Toolbox connection, you need to know the server's phone number. For other information you need, see your Comm Toolbox documentation.
Comm Toolbox Serial information
•	the server's phone number
•	your modem type
•	your phone type (dial or touch tone)
•	the name of your connection script (if you require a special connection script).
For other information you need, see your Comm Toolbox documentation.
FirstClass modem information
To configure a FirstClass modem connection, you need the following information:
•	the server's phone number
•	your modem type
•	the port to which your modem is connected
•	your phone type (dial or touch tone)
•	the name of your connection script (if you require a special connection script).
IPX information
To configure an IPX connection, you need to know the server's network name.
ISDN information
To configure an ISDN connection, you need the following information:
•	the server's phone number
•	the ISDN protocols that are appropriate for your ISDN adapter and the server to which you are connecting.
Serial modem information
To configure a serial modem connection, you need the following information:
•	the server's phone number
•	your modem type
•	the port to which your modem is connected
•	your phone type (dial or touch tone)
•	the name of your connection script (if you require a special connection script).
Windows modem (TAPI) information
To configure a Windows modem (TAPI) connection, you need the following information:
•	the server's phone number
•	the modem you want to use for this connection (if you have multiple modems configured on your computer)
•	the name of your connection script file (if you require a special connection script)
•	the line number you want to use for this connection (if your modem supports multiple lines).
To configure a connection
After you have gathered all the information you need to configure your connection, you can configure service setup information. For AppleTalk and IPX protocols, this is all you need to do.
The other protocols require that you also configure connection information.
Where information is saved
Service setup information is stored in your settings file.
Connection information is stored in the .fcp files that are located in FirstClass' FCP folder. There is one .fcp file for each connection type. Normally, all settings files that use the same connection type obtain their connection information from the same .fcp file.
For protocols other than TCP/IP and UDP/IP
By default, only TCP/IP and UDP/IP are supported by the client. If you want to use another protocol, you must install files that support your protocol. These files are available for download from the Conferences/Software Libraries section of FirstClass Online or the Downloads section of our web site.
Download the appropriate .fcp file to the FCP folder inside the FirstClass application folder. If you are going to use a modem, you must also download the appropriate modem file (.mdm) to FirstClass' Modems folder.
Configuring service setup information
To configure service setup information:
1	Open the FirstClass FirstClass Login screen.
If FirstClass is already running, choose Collaborate > Connect.
2	Make sure the settings file you want to configure is selected at "Address".
If the settings file for the server is not listed here, do one of the following:
•	click Browse to find and select it
•	update home.fc
•	create a new settings file for the server.
To create a new settings file, type the name you want to give the settings file at "Address".  If you are using Windows, make sure the name ends with .fc.
3	Click Setup.
4	Update the Service Setup form.
For AppleTalk and IPX
Your connection is now configured.
For all other protocols
5	Configure connection information.
Configuring connection information
You need to configure connection information for the following protocols:
TCP/IP or UDP/IP
Comm Toolbox or Comm Toolbox Serial
FirstClass modem
ISDN (CAPI)
Serial modem
Windows modem (TAPI).
Configuring Comm Toolbox/Comm Toolbox Serial connections
To configure connection information:
1	Click Configure on the Service Setup form.
2	Choose Comm Toolbox or Comm Toolbox Serial at "Protocol".
3	Click Comm Toolbox Setup and configure the settings as instructed by your Comm Toolbox documentation.
If you are using Comm Toolbox Serial, you also need to update the fields on the Settings tab.
Configuring other connections
To configure connection information for TCP/IP, UDP/IP, FirstClass modems, ISDN, serial modems, or Windows modems:
1	Click Configure on the Service Setup form.
2	Update the Settings tab of the configuration form.
After you have configured connection information for modems, you will never need to reconfigure this information unless you install a different type of modem, or connect the modem to a different serial port.
If you want different behaviors for the same protocol
When you configure a connection, you are updating the .fcp file that is used for all connections of this type (for example, all modem connections).
If you want to make a change that only applies to one settings file, and not to others that use the same .fcp file, you can create a new .fcp file. To do this, create a duplicate of the applicable .fcp file in FirstClass' FCP folder, then name the duplicate, using the extension .fcp.
Example
You have a modem connection for which you want the speaker on for some systems, but off for others. You copy MODEM.FCP and rename the duplicate QUIET.FCP to accommodate turning the speaker off. Then you can create a new settings file that uses QUIET.FCP at "Connect via", or just change the selection as necessary when you log in.
Configuring advanced connection information
Very rarely, you may need to configure things such as window and packet size, or turn on tracing. In normal circumstances, you never need to do this.
This applies to all protocols, including AppleTalk and IPX.
If you need to configure advanced connection information:
1	Click Configure on the Service Setup form.
2	Update the Advanced tab of the configuration form as required.
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Modem concepts and standards
This document explains:
•	flow control and handshaking
•	baud rate, or bits per second (bps)
•	fall back
•	hardware carrier detection
•	DTR hangup
•	modulation (speed) standards
•	error correction standards
•	data compression standards
•	how FirstClass works with your modem.
Flow control and handshaking
Most high speed modems can still connect to older, lower speed modems. When they do, they receive information from the compute at high speed, and send the data out at a lower speed. Therefore, they may have to instruct the computer to slow down periodically.
Flow control is the method a modem uses to control the quantity of data the computer sends to the modem. It ensures that data is not lost if it is sent to the modem faster than the modem can accept it.
There are two widely recognized standard methods for flow control: software handshaking (using XON/XOFF) and hardware handshaking (using RTS/CTS).
Software handshaking (XON/XOFF)
You cannot use software handshaking with FirstClass. However, most high speed modems default to RTS/CTS handshaking, as do many other programs. Therefore, you must ensure that any modem setup strings you create do not turn on XON/XOFF handshaking.
Hardware handshaking (RTS/CTS)
If you use a high-speed modem or a modem with error correction or data compression, you must enable hardware handshaking. Hardware handshaking uses the Clear to Send (CTS) and Request to Send (RTS) pins on the modem cable to control data flow.
To use hardware handshaking, you must have a hardware handshaking cable (that is, a cable with the RTS and CTS lines enabled at both ends).
Baud rate
The measure of how fast a modem transfers data. The faster the baud rate, the faster the data transfer. If you divide the baud rate by 10, you get a rough estimate of the number of bytes (or characters) transferred per second, and this provides an idea of how long a file transfer will take. For example, a 2400 bps modem can transfer about 240 bytes per second (that is, about 1Kb every four seconds). Therefore, a 25Kb file would take about 100 (25x4) seconds to transfer.
Fall back
When two modems first connect, they negotiate to find the best communication speed they can both use for the connection. Often this speed is less than the maximum speed supported by one of the modems; in this case, the faster modem "falls back" to the lower rate. For example, if modems with speeds of 9600 bps and 14400 bps try to connect, they would negotiate a connection at the speed of 9600 bps. The modem whose speed is 14400 bps would then fall back to 9600 bps.
Hardware carrier detection
FirstClass detects that the connection to a server has been dropped using one of the following methods:
•	it monitors the length of time before it receives a response from the server
•	it monitors the state of the Carrier Detect pin on the modem cable.
The second method identifies a dropped connection most accurately. To use this method, you must enable hardware carrier detection when you configure your modem connection. The modem turns this pin on when it receives a special tone, called the carrier, from the remote modem. When the modem stops receiving this tone, it turns this pin off, and FirstClass reports that the connection has been dropped.
DTR hangup
A computer can tell a modem to hang up a call in the following ways:
•	send the Attention string followed by the Hangup string
•	configure the modem to monitor the Data Terminal Ready (DTR) pin, then turn off the DTR pin.
We recommend that you do not use the Attention string method. If the modem speed does not match the computer speed, the Attention string will not be received correctly, and the modem might not hang up. Since speeds can easily get out of sync during some negotiations, the DTR line is more reliable.
If you select the DTR pin method, FirstClass tries to hang up the modem by turning off the DTR line, waiting for an OK, then sending the Hangup command.
Modem standards
The standards described here fall into three categories: standards for modulation (speed), error correction, and data compression. Most modem standards are referred to by a code assigned by the Consultive Committee for International Telephony and Telegraphy (CCITT).
Note
Take care when choosing modems with proprietary standards for high-speed communication, error correction, or data compression. These features only work when the modems at both ends of the connection support the same standards.
Modulation (speed) standards
Modulation (or speed) standards involve the rates and ways modems communicate with each other, and how they negotiate the best communication speed they can both use for the connection. These are common modulation standards:
V.22
The CCITT standard for data transmission at speeds up to 2400 bps.
HST
The USR proprietary standard for data transmission at speeds from 9600 to 16800 bps, depending on the model.
The reverse channel is much slower. If you are connecting to another type of modem, the best speed you can expect is 2400 bps.
Hayes V-series
The Hayes proprietary standard for data transmission at speeds up to 9600 bps.
The reverse channel is much slower. If you are connecting to another type of modem, the best speed you can expect is 2400 bps.
V.32
The CCITT standard for data transmission at speeds up to 9600 bps.
V.32bis
The CCITT standard for data transmission at speeds up to 14400 bps.
V.32terbo
The AT&T proprietary standard for data transmission at speeds up to 19200 bps.
V.fc
The Rockwell chip set proprietary standard for data transmission at speeds up to 28800 bps.
V.34
The CCITT standard for data transmission at speeds up to 28800 bps.
K56flex
The Lucent and Rockwell proprietary standard for 56K modems.
x.2
The US Robotics proprietary standard for 56K modems.
V.90
The CCITT standard for 56K modems.
Error correction standards
Error correction standards provide a way of correcting errors that result from outside interference, such as noise on the phone line. Error correction ensures that data coming out of the receiving modem is exactly the same as data going into the sending modem. Error correction standards correct only those errors occurring between the two modems; they cannot correct errors occurring between the modem and the computer (the modem-computer connection is considerably more reliable when proper cables are used and connections secured).
These are common error correction standards:
V.42
The CCITT error correction standard.
MNP Error Control
The Microcom Networking Protocol (an early error correction standard).
The V.42 standard is partly based on MNP.
Data compression standards
Data compression standards provide a way of compressing data at the sending modem, transmitting it across the modem link in compressed form, and then expanding it at the receiving modem. If the data can be compressed, data compression increases the effective throughput. If the data cannot be compressed (for example, if it has already been compressed with a utility such as Stuffit or PKZip), then modems with data compression give little benefit.
These are common data compression standards:
V.42 bis
The CCITT data compression standard.
This standard has a theoretical maximum compression ratio of four to one.
MNP Level 5 Compression
The Microcom data compression standard.
This standard, part of the V.42bis standard, has a lower maximum compression ratio (two to one). MNP 5 actually slows down the transfer of already compressed files.
How FirstClass works with your modem
The interaction of FirstClass with your modem begins when you connect to a server. FirstClass automates the stages of the login process, using the connection configuration stored in the connection file. At each stage of the process, two status lines appear on the FirstClass Login screen. The first line shows the action in progress. The second line shows the commands sent to the modem and the responses from the modem.
The following stages occur during login:
Stage 1
FirstClass sends the Reset string to the modem on the serial port (Mac OS) or the COM port (Windows) specified in the connection file and waits for the modem to return an OK response. The status line displays "Resetting modem" followed by the Reset string sent to the modem.
Stage 2
When the server receives the OK response, it sends the Setup string and waits for an OK. The status line displays "Setting up modem" followed by the Setup string sent to the modem.
Note
Because each modem requires a different Setup string, you must select the correct modem type on the Connection form.
Stage 3
If any optional settings (such as Speaker, H/W Handshake, DTR Hangup, or Carrier Detect) are set in the MODEM.FCP file, FirstClass sends the Option string to the modem. The status line displays "Sending modem options" followed by any optional commands sent to the modem.
Stage 4
FirstClass sends the Dial String to the modem and waits for a CONNECT response from the modem. The Dial string contains the phone number defined in the settings file. The status line displays "Dialing the number" followed by the Dial string sent to the modem. After the Dial string has been sent, the first status line displays "Waiting for connection". Make sure the phone number on the status line is correct, including any prefixes (such as 9 or 1) and area codes.
Stage 5
If the modem is able to negotiate a connection, the status line displays the messages "Negotiating connection" and "Connected". When the connection is established, your user ID and password are sent to the server. If they are correct, your FirstClass Desktop opens.
If all server modems are busy, your modem returns a BUSY response and the login fails. If your modem is unable to connect, it returns a NO CARRIER response and the login fails.
If any stage in the login process fails, the login stops.
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Modem connection scripts
If you use a modem and require a special connection script to connect to a server, you can create a connection script file, then choose this file at "Script" when you configure connection information.
A connection script executes automatically when a modem initiates or answers a call. You may need such a script, for example, if you are connecting through an X.25 network.
To create a connection script file:
1	Use a text editor to type the appropriate connection script commands.
2	Save the script as a plain text file with an extension of .fcl.
3	Move the file into FirstClass' Scripts folder.
Connection script commands
Use the following commands as required to build your connection script.
DELAY
Syntax
DELAY time
Description
DELAY tells the server to wait for a specified time. The value time is the time you want the server to wait, in 60ths of a second.
Example
DELAY 600
tells the server to wait 10 seconds
DISPLAY
Syntax
DISPLAY text -D
or
DISPLAY "text string" -D
Description
DISPLAY sends text to the modem for display purposes only. The value text is the text you want to send to the modem. If this text contains spaces, enclose the whole text string in single or double quotation marks.
Example
DISPLAY "X.25 login sequence starting" -D
displays this:
X.25 login sequence starting
SEND
Syntax
SEND text
or
SEND "text string"
Escape sequences
You can add the following escape sequences to this command:
•\r - adds a carriage return after the text
•\n - starts the text on a new line.
Description
SEND sends text to the modem. The value text is the text you want to send to the modem. If this text contains spaces, enclose the whole text string in single or double quotation marks.
Example
SEND an63z\r
sends the password an63z, followed by a carriage return, to the modem
WAITFOR
Syntax
WAITFOR string1 string2 ... stringn -T timeout
or
WAITFOR "string1" "string2" ... "stringn" -T timeout
Description
WAITFOR tells the server to wait a specified time for any of the strings included in this command to be returned from the remote modem. If none of these strings are received during this time, the server terminates the connection attempt and reports a 1083 error (timeout in script).
The string values are the strings you want the server to wait for. If a string contains spaces, enclose it in single or double quotation marks. You can list as many strings as you want.
The timeout value is the time you want the server to wait, in 60ths of a second.
Example
WAITFOR service disconnect "no carrier" -T1200
tells the server to wait 20 seconds for any of these strings: service, disconnect, or no carrier
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Folders installed with FirstClass
When you install FirstClass, a folder is placed on your hard disk. This folder contains the FirstClass application and other FirstClass files and folders. The FirstClass folders are described here.
Make sure that the FirstClass application remains in the same folder as the FirstClass folders, or FirstClass will not run properly.
Download
This is the default folder for files that you download from the server.
FCP
This folder contains connection files (.fcp files) that are used to connect to servers. The file names indicate the connection types.
Images
This folder contains graphics files that you can choose when assigning background pictures to FirstClass windows and objects. Adding files to this folder is one way to expand the basic set of pictures that come with FirstClass.
Modems
This folder contains command files (.mdm files) for modems. The file names indicate the modems. When you choose a modem as part of your configuration, the contents of this folder are reflected in the list of available modem choices.
Plugins
This folder contains viewers for various types of graphics files. These viewers enable FirstClass to display these files. If your administrator added special chat client extensions, these extensions are also in this folder.
Scripts
This folder is the place to store any modem connection script files (.fcl files) that you need to connect to a server.
Settings
This folder contains any settings files (.fc files in Windows) supplied with FirstClass, plus any additional files that you create.
Tools
This folder contains the dictionaries supplied with FirstClass. These dictionaries are used when FirstClass spell checks text.
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